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. Step Reckoner was the first calculator that could perform all four arithmetic operations. It

was invented by Gottfried Wilhelm Leibniz in 1670s.

In 1944, Prof. Howard Aikens built the first electro-mechanical computer named Mark-I.
The two features of third generation computers are as follows:

e These computers were made of ICs.

e The use of the ICs reduced the size and increased the processing speed of the computers.

. In 1980’s, Very Large Scale Integration (VLSI) came into existence in which thousands of

transistors were placed on a single chip called microprocessor.
The two features of fifth generation computers are as follows:
1. Improved size, cost, speed and performance

2. Use artificial intelligence

a. Fourth generation computer

A smartphone is a mobile phone that can be used as a computer also which can be used to
make calls, send SMS, play games, watch videos, click pictures and do a lot of things.

It is smaller in size than a tablet and can be held in a hand.
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c. Replace all
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m Advanced Features of Word 2016
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4. a. To use thesaurus tool, follow the given steps:
Step 1: Select the word.
Step 2:  Click on Review tab.
Step 3: Click on the Thesaurus tool under Proofing group.

The Thesaurus pane opens on the left side of the window. It displays a list of synonyms for
the selected word.

Step 4: Click the down arrow and select Insert or Copy.
b. To use the replace tool, follow these steps:
Step 1:  Click on Home tab.

Step 2:  Click on Replace tool in Editing group. A Find and Replace dialog box opens. The
Replace tab is selected by default.

Step 3: Type the word/words to be searched and replaced in the Find what box.
Step 4: Type the word/words to replace it with the Replace with box.

Step 5:  Click on Find Next button. Word searches for the word or text. If the word is in the
text, it gets highlighted. You can replace the word/words by clicking on Replace
button or Replace All button.

Repeat the above steps till all the words have been replaced in the document. A message
box appears showing that words are replaced and asking whether you want to search more
or not.

Step 6: Click Yes if you want to search more and No if you don’t want to search.
Step 7:  Click on Close button to close the Find and Replace dialog box.
¢. Orientation of a paper means the direction in which the text or image appears on a page.
Word has two types of page orientations—Landscape and Portrait.
d. To change line spacing for a single paragraph, follow the given steps:
Step 1: Select the text and place the cursor.
Step 2: Click on Home tab.
Step 3: Click on Line and Paragraph Spacing tool in Paragraph group.
Step 4:  Hover your mouse pointer on the various line spacing options.
The paragraph will show the preview of the line spacing. Choose the line spacing you want.

e. The Mail Merge feature in Word provides you with a tool to create and send multiple letters
and invitations to many people at the same time. Each letter or invite is addressed to different
people but has the same text.

5. a. To use thesaurus tool, follow the given steps:
Step 1:  Select the word.
Step 2:  Click on Review tab.
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Step 3: Click on the Thesaurus tool under Proofing group.

The Thesaurus pane opens on the left side of the window. It displays a list of synonyms for
the selected word.

Step 4: Click the down arrow and select Insert or Copy.

b. The Mail Merge feature in Word provides you with a tool to create and send multiple letters
and invitations to many people at the same time. Each letter or invite is addressed to different
people but has the same text.

The main steps of mail merge are given below:

1. Create the main document: The main document has the body of the letter or invitation
that has to be sent. The document contains merge fields. They are the places where data
is inserted from the data source.

2. Create the data source: The data source contains the details of all the people to whom
the letters will be sent. It can have the name, address, telephone numbers, e-mail address,
etc. These details are inserted in the main document.

3. Merged document: it combines both the documents.
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m Formatting a Presentation
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1. ENTRANCE 2. EMPHASIS 3. EXIT 4. MOTION PATH
1. a (i) b. (i) c. (iii) d. (iii) e. (ii)

. (iii) g. (iii)
2. a. Theme b. Insert c¢. Format d. Animation  e. Three

f. Subtle g. Emphasis
3. aF b. T c.F d.F
4. a. Themes are an in-built feature which offer you a quick way of changing the layout and design

of the presentation that you have created.

b. Slide Master in PowerPoint is used to create the default layout and appearance of the slides

in the presentation.
Steps to change background of the slides:

Step 1:  Click on Design tab.
Step 2:

task pane opens.
Step 3:

Select Format Background command in Customize group. A Format Background

Click on the radio button of the fill option you want. The fill options are- Solid Fill,

Gradient Fill, Picture or Texture fill and Pattern fill.

c. The different type of animation effects are : Entrance, Emphasis and Exit.

. To insert a SmartArt in your slide, follow the given steps:

Step 1: Click on Insert tab.

Step 2:  Select SmartArtinIllustration group. A Choose a SmartArt Graphic dialog box appears.
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Step 3:

Step 4:

Choose a category from the left section. Then choose a graphic layout from the
middle section. As you click on a graphic layout option, a preview of the layout
with its details appear in the right section.

Click OK button. The SmartArt is inserted on the current slide.

e. To remove an animation effect from the Animation Pane, just click on an effect and press
the Delete key. The animation effect is removed.

5. a. To add animations to Sara’s presentation, open PowerPoint and follow the given steps:

Step 1:
Step 2:
Step 3:
Step 4:

Step 5:
Step 6:

Click on the text or image you wish to animate.
Click on Animations tab.
Click on More button in the Animations group.

Choose an animation effect from categories like Entrance, Emphasis, Exit, or Motion
Paths.

Use the Animation Pane to view and manage multiple animations.

Adjust timing and effect options if needed.

b. To apply a transition, follow the given steps:

Step 1:

Step 2:
Step 3:
Step 4:
Step 5:

From the Slide Navigation pane, select the slide on which you want to apply the
transition.

Click on Transitions tab.
Click on More button in the Transition to This Slide group.
Choose a transition effect (e.g. Fade, Push, Wipe) from the gallery.

Click a transition to apply to the selected slide. A preview of the transition effect
appears in the slide area.

| TecnZowe S

( Ler's Sowve

/9 a. Themes

b. Design Tab c¢. Format Background d. Home Tab

( Ler’s ExPLORE
/
( / Do it yourself.

m Introduction to Excel 2016

Ler’s PLUG=IN g

Do it yourself.

6 | Touchpad PLUS (Version 2.2)-V (Answer Key)

[

Page no. 49)

LK



@ (Page no. 52)

1.¢c 2.d. 3.e. 4. a. 5. b.
1. a. () b. (i) c. (iii) d. (i)

2. a.Spreadsheet b. Cancel c.Ctrl +S d. Formula bar
3. aT b. F c. F d.F

4. a. The two features of excel are as follows:

e When we make a change at one place in a worksheet, the entire spreadsheet is automatically
recalculated.

e [t is very easy to search and replace figures in a spreadsheet with just one command.
b. To save workbook, follow these steps:
Step 1: Click on the File tab.

Step 2: If we are saving the workbook for the first time or saving the workbook we are
currently working on, click on Save command. If we want to save the current
workbook with a new name, click Save As. The Save As pane appears in the Backstage
View.

Step 3: Click on Browse option. Navigate to the folder where you want to save your
workbook.

Step 4: Type a name for your file in the File name box.
Step 5:  Click on Save button.

c. A worksheet is a spreadsheet with rows and columns where we can type and store data,
and perform various operations on the data. To create a new workbook, follow the given
steps:

Step 1: Click on File tab. A backstage view appears.
Step 2: Click on New in the left pane.
Step 3:  Click on Blank workbook.

d. Active cell is the cell that is currently active or selected. It can be recognized by its green
outline. You can type data into an active cell only.

5. a. Main Components of Excel 2016 Window:
e Title Bar — Shows file name and program name.
e Quick Access Toolbar — For quick commands like Save, Undo.

e Ribbon - Contains tabs and tools for formatting, formulas, etc.
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Formula Bar — Shows or edits data/formulas in the selected cell.

Name Box — Displays the address of the active cell.

Worksheet Area — Grid of rows and columns to enter data.

Worksheet Tabs — Switch between different sheets.

Status Bar — Shows info like sum, average, and workbook status.

Scroll Bars — Move around the worksheet.

e Zoom Control — Zoom in or out of the worksheet.
b. To save a workbook, follow the given steps:
Step 1:  Click on the File tab.

Step 2: If you are saving the workbook for the first time or saving the workbook you are
currently working on, click on Save command. If you want to save the current
workbook with a new name, click Save As. The Save As pane appears in the
Backstage View.

Step 3: Click on Browse option. Navigate to the folder where you want to save your
workbook.

Step 4: Type a name for your file in the File name box.

Step 5:  Click on Save button.
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2. Do it yourself.
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1. Ctrl + A 2. Shift 3. Ctrl
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1. a. () b. (i) c. (iii) d. (iii) e. (iii)

2. a.Cells b Column ¢. Number d. Delete e. Editing

3. afF b. F cT d.T eT

4. a. Redo command is used to redo the last Undo action. Redo command works only when you
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have given an Undo command.

A range is a rectangular section of cells which are next to each other and at least one side
of their border is common. To select a range using the mouse, click on the top left cell and
drag the mouse while holding the left mouse button till the bottom right cell is selected.
The range will be selected.

To copy data, follow the given steps:

Step 1: Select the cells you want to copy.

Step 2:  Click on the Home tab.

Step 3:  Select Copy button from Clipboard group.

Step 4: Click on the cell where you want to copy the selected range.

Step 5:  Select Paste button in clipboard group.

. The AutoFill feature in Excel is used to automatically fill series of data in rows and columns

based on the values of other cells.

To use the AutoFill feature in a series, follow the given steps:
Step 1: Type the first number in a series.

Step 2:  Select the cell and the cells that we want to AutoFill.
Step 3:  Click on Home tab.

Step 4: Click on Fill button in Editing group.

Step 5:  Click on Series from the Fill drop-down menu. A Series dialog box opens. Enter the
step value. We can also change or select other values.

Step 6: Click OK. The cells are filled with the series.

. To insert date or time, follow these steps:

Step 1: Select the cell where we want to edit the date or time.
Step 2: Click on Home tab.

Step 3:  Click on the Number format dialog box launcher.
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Step 4: A Format Cells dialog box appears. Select time option in the Category section. A
list of formats is displayed.

Step 5: Choose the format we want.
Step 6: Click OK button.
5. a. To move the list of books to another worksheet, Raj can follow these steps:
Step 1:  Select the cells containing the list of books.
Step 2:  Right-click on the selected area and click “Cut” or press Ctrl + X on the keyboard.
Step 3:  Go to the other worksheet (click on the worksheet tab at the bottom).
Step 4: Click on the cell where he wants to place the list.
Step 5: Right-click and select “"Paste” or press Ctrl + V to move the list.
To copy the names of the authors to a new column in the same worksheet:
Step 1: Select the cells that contain the authors’ names.
Step 2:  Right-click and choose “Copy” or press Ctrl + C.
Step 3:  Click on the first cell of the new column where he wants to paste the data.
Step 4: Right-click and select “Paste” or press Ctrl + V.

b. After Emma types “Jan” in the first cell, she can use the Auto Fill feature to complete the
column as follows:

Step 1:  Click on the cell that contains “Jan”".

Step 2: Move the cursor to the bottom-right corner of the cell until it becomes a small plus
sign (this is called the fill handle).

Step 3: Click and drag the fill handle downwards along the column.
Excel will automatically fill the cells with the next months (Feb, Mar, Apr, etc.).
Step 4: Release the mouse button when she has reached the desired number of months.

This feature helps save time and ensures the list of months is filled accurately.
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Periodic Assessment-2
(Based on chapters 3 to 5)

¥*

2. Swivel

M A E
A.
A K

1. Zoom

. 1

2. | O Shift cells up

3. ’ () Entire row

4. | () Entire column

C. 1. Maximize button
4. Undo

A
L _{

~ ™

¥

3. Bounce 4. Random Bars

Deletes selected cells and shift the cells on the right to left.
‘Deletes selected cells and the cells below shift up.
‘Deletes selected row and the row below shifts up.

Deletes selected column and the column shifts from right to left.

2. Excel 3. Delete key

5. Close button

D. Sahil can use the Bullets and Numbering tool to make his list more creative. It helps organise
points clearly and adds visual appeal to the presentation.

Test Sheet-1

(Based on chapters 1 to 5)

A. 1. (i) 2. () 3. (i) 4. (i)
B. 1. Second 2. Third

C. 1.F 2. T

D. 1.iii 2.1v

A. 1

Section A
5.(G) 6.(Gi) 7.(G) 8.(i) 9.(G) 10.() 11. (i)
3. Centimetre 4. Format 5. Number
3.7 4. F 5T
3.ii 4.v 5.1

Section B

. Step Reckoner, the first calculator that could perform all four arithmetic operations, was

invented by Gottfried Wilhelm Leibniz in 1672.

2. To use the Thesaurus tool, select a word, go to the Review tab, click Thesaurus in the Proofing
group, then choose and insert or copy a synonym from the pane.

3. The different type of animation effects are : Entrance, Emphasis and Exit.
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4. Itis the cell that is currently active or selected. It can be recognised by its thick green border.
You can type data into an active cell only.

5. Redo command is used to redo the last Undo action. Redo command works only when you
have given an Undo command.

B. 1. The two features of fifth generation computers are as follows:
1. Improved size, cost, speed and performance.
2. Use artificial intelligence.
2. To change line spacing for a single paragraph, follow the given steps:
Step 1: Select the text and place the cursor.
Step 2:  Click on Home tab.
Step 3: Click on Line and Paragraph Spacing tool in Paragraph group.
Step 4: Hover your mouse pointer on the various line spacing options.
The paragraph will show the preview of the line spacing. Choose the line spacing you want.

3. Slide Master in PowerPoint is used to create the default layout and appearance of the slides
in the presentation.

Steps to change background of the slides:
Step 1:  Click on Design tab.

Step 2: Select Format Background command in Customize group. A Format Background
task pane opens.

Step 3: Click on the radio button of the fill option you want. The fill options are- Solid Fill,
Gradient Fill, Picture or Texture fill and Pattern fill.

4. A worksheet is a spreadsheet with rows and columns where we can type and store data, and
perform various operations on the data. To create a new workbook, follow the given steps:

Step 1:  Click on File tab. A backstage view appears.
Step 2: Click on New in the left pane.
Step 3:  Click on Blank workbook.
5. Toinsert date or time, follow these steps:
Step 1: Select the cell where we want to edit the date or time.
Step 2:  Click on Home tab.
Step 3: Click on the Number format dialog box launcher.

Step 4: A Format Cells dialog box appears. Select date option in the Category section. A
list of formats is displayed.

Step 5: Choose the format we want.
Step 6: Click OK button.

12, Touchpad PLUS (Version 2.2}V (Answer Key) :<<<<<<<<<<<<<

2
@..‘)

=
[LN



m Internet and E-mail
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1.d.

3. b. 4. c.
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a

2.a.

| Test Your Skus &

a. (iii) b. (ii) c. (i) d. (i) e. (ii)
a. BCC b. To c. CC d. Attachment e. Website
a.F b. T c.F d.F

1

2.
3.
4

a.
b.

Dial-up connection requires users to link their phone line to a computer to access the Internet.

Wireless provides great speed as it uses radio frequency to connect to the internet. Wireless
connections are possible through modem. Whereas, mobile Internet provides user to access
internet using a smartphone and network provided by service provider.

An Electronic mail or e-mail can be defined as the process of exchanging messages
electronically through a communication network by using computer. Advantages of email
are: an e-mail can be sent anytime and from anywhere in the world. An e-mail can be sent
to many people at a time.

To open a web page, follow these steps:

Step 1: Type the URL browser's Address bar.
Step 2: Press the Enter key from the keyboard.
Follow the given steps to send an e-mail:

Step 1: Click on Compose button on the top left corner of your Web browser window, to
create and type a new E-mail.

Step 2: This will open the New Message window on the screen.

Step 3: The New Message window has many fields: To, CC, BCC, Subject. Fill the desired
one. The e-mail is typed in the main white body of the New Message window.

Step 4: After completing the text of the e-mail, click on Send button to finally send the
e-mail to your friend.

Amit should open a web browser, type the given URL in the address bar, press Enter, and
the website will open.

Ravi should open his email, click Compose, type the teacher's email, add a subject, write a
short message, attach his project file, and click Send.

Ravi should double-check the attachment and the teacher’'s email ID before sending. P
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1. Sumit should compose a new email, click the attachment icon, select the music file from his
device, and then send the email to his friend.
2. Sushant should write Ajay’s email address in the “To" field and the others’ email addresses in
the "BCC" field.

( Ler’s ExPLORE
Ya4 .
/ Do ityourself.

( Ler’s Ger BeTTer
/’/ Do it yourself.

Data Processing
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Page no. 89)

Do it yourself.

(@ (Page no. 92)

a.COMPUTER b.DATA ¢.INFORMATION

| Test Your Skus ©

1. a (i) b. (ii) c. (iii)

2. Subject Marks Obtained Subject Marks Obtained

(Ascending order) (Descending Order)
English 40 Maths 90
Hindi 56 Social studies 89
Computer 68 Science 75
Science 75 Computer 68
Social studies 89 Hindi 56
Maths 90 English 40

3. a. Data refers to the raw input. When this data is processed, the outcome received is known as
information.

Touchpad PLUS (Version 2.2)-V (Answer Key) <<<<<<<<<<<<<<<<<<




O

. Decoding is the process of converting a coded message into understandable language.
¢. Some of the ways in which we can represent information are:
« We can represent information in the form of tables.
 We can represent information in the form of pictures, drawing and so on.
» We can represent information in the form of maps.
 We can represent information in the form of pictograms.
4. a. Tom should arrange the ages in ascending order (from smallest to largest).
Sorted list: 9, 11, 12, 15
He can do this by comparing each number and placing them in increasing order.
b. The code shifts each letter back by one alphabet.
H->G
P—>0O
P—>0O
E—>D

So, "Hppe” becomes "Good".

| TecnZove

( Ler's Sowve
/// 1. No Parking 2. Veg. & No. Veg. 3. Zebra Crossing 4.No U turn

( Ler’s ExPLORE
/9 Do it yourself.

Periodic Assessment-3

(Based on chapters 6 & 7)
A. 1. ORANGE 2. EDUCATION 3. BOOKS 4. SCHOOL
B. 1.ii 2.1 3.iv 4. iii
C. 1. Pictures 2. Maps 3. Tables 4. Pictograms
D. She can send an e-mail using Bcc field.
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m Conditional Blocks in Scratch
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(@ (Page no. 100)

1. Ask and wait 2. Wrap Blocks 3. Cap Blocks

Tt Your Suus @

5.

1

2.
3.
4

a.

a.

a.

a.

a.

(iii) b. (ii) c. (i) d. (i)
Hat b. Touching color c. Variables d. Ask
F b. T cF d.F
Boolean blocks are condition blocks which return the values “true” or “false” or the number

"0" or "1" depending on how they are used in the script.

. The sensing blocks in Scratch sense the input from the keyboard or the mouse at the time

of execution of a script.

The forever block is used to run a set of instructions continuously until stopped. The instructions
inside this block will be executed in a loop until the Stop button is clicked by the user.

Variables can store numbers as well as letters. A variable that stores numbers is called a
numeric variable. These numbers are used in calculations. Examples are 48, -986, 12345, etc.

A variable that stores letters in the form of strings or characters is called string variable.
A string variable can store names, words, sentences, numbers, and enclosed in quotation
marks. For example, “Kavita”, "I am 12 years old” and "12345". These variables are not used
in calculations.

Forever block b. (iii)

( Ler's Sowve

/9 Do it yourself.

( Ler’s EXPLORE

/’/ Do it yourself.
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m Concept of Smart Living
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Do it yourself.
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1. a () b. (i) c. (ii) d. (i)

2. a.lights b. Smart homes c. Al d. Temperature

3. aT b. T cT d.T eT

4. a. Smart Homes are homes that use internet connected devices to empower remote monitoring

and management of appliances and devices such as for lighting and heating.

The following are the benefits of smart homes:

e Save power by automatically switching off lights when users are asleep.

e Offer smart security to protect the home and belongings.

o Allow easy access to all connected devices through a smartphone.

e Enable remote control of gadgets, like adjusting the home’s temperature.
b. Smart TV, Video Doorbells, Smart Lighting

¢. Smart Home owners are always connected to the Internet and they use Al-enabled devices
to monitor and manage appliances and systems with remote control. These devices use the
various domains of Al like Computer Vision, Natural Language Processing and Data Science.

d. Smart camera is used to monitor the indoor and outdoor activities. It not only records the
movements but also sends alerts for suspicious movements.

5. a. Video doorbell has a built-in camera to watch and a microphone to talk to the visitor through
the intercom.

b. Smart lights can turn on automatically, helping them move safely at night. Cameras let family
members check on them remotely. Smoke detectors send alerts if there's fire or smoke,
helping prevent danger and keeping them safe.

( Ler's Sowve
/9 a. Video Doorbell b. Smart Speaker ¢. Smart TV

( Ler’s EXPLORE
/9 Do it yourself.

( Ler’s Ger BerTer
/9 Do it yourself.
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Periodic Assessment-4

(Based on chapters 8 &9)
A. C-Blocks, Control blocks 2. Hat Blocks, Event Blocks
Reporter Blocks, Operator Blocks
B. Smart Speakers 2. Smart Smoke Detectors 3. Video Doorbells

Hat blocks always comes on the top.
A Script is made up of number of blocks.
When it comes to home security, smart cameras are the most important devices.

Smart homes are great in saving energy.

A R A

In scratch, a program is called a Script.

D. She can use Smart Cameras.

Test Sheet-2

(Based on chapters 6 to 9)

Section A
A. 1. (i) 2. (iii) 3. (ii) 4. (i)
5. (iii) 6. (ii) 7. (i) 8. (iii)
B. 1. CC 2. Websites 3. Variables 4. Ask 5. Temperature
1. F 2. T 3. F 4. T 5T
D. 1. b 2. e. 3.d. 4. a. 5.c
Section B

A. 1. Data refers to the raw input. When this data is processed, the outcome received is known
as information.

2. Dial-up connection requires users to link their phone line to a computer to access the Internet.

3. Boolean blocks are condition blocks which return the values “true” or “false” or the number
"0" or 1" depending on how they are used in the script.

4. Tosend an email, click Compose, fill in the To, CC, BCC, and Subject fields, type your message
in the main body, and then click Send.

5. Information can be represented using tables, pictures or drawings, maps, and pictograms.

6. Smart camera is used to monitor the indoor and outdoor activities. It not only records the
movements but also sends alerts for suspicious movements.

7. Smart TV, Video Doorbells, Smart Lighting
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B. 1. Variables can store numbers as well as letters. A variable that stores numbers is called a
numeric variable. These numbers are used in calculations. Examples are 48, —-986, 12345,
etc.

A variable that stores letters in the form of strings or characters is called string variable.
A string variable can store names, words, sentences, numbers, and enclosed in quotation
marks. For example, “Kavita”, “I am 12 years old” and "12345". These variables are not used
in calculations.

2. Smart Home owners are always connected to the Internet and they use Al-enabled devices
to monitor and manage appliances and systems with remote control. These devices use the
various domains of Al like Computer Vision, Natural Language Processing and Data Science.

3. The forever block is used to run a set of instructions continuously until stopped. The
instructions inside this block will be executed in a loop until the Stop button is clicked by
the user.

4. To open a web page, follow these steps:
Step 1: Type the URL browser's Address bar.
Step 2: Press the Enter key from the keyboard.

5. Smart Homes are homes that use internet connected devices to empower remote monitoring
and management of appliances and devices such as for lighting and heating.

The following are the benefits of smart homes:

e Save power by automatically switching off lights when users are asleep.

o Offer smart security to protect the home and belongings.

o Allow easy access to all connected devices through a smartphone.

e Enable remote control of gadgets, like adjusting the home’s temperature.

6. An Electronic mail or e-mail can be defined as the process of exchanging messages
electronically through a communication network by using computer. Advantages of email
are: an e-mail can be sent anytime and from anywhere in the world. An e-mail can be sent
to many people at a time.

7. Wireless provides great speed as it uses radio frequency to connect to the internet. Wireless
connections are possible through modem. Whereas, mobile Internet provides user to access
internet using a smartphone and network provided by service provider.
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